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TOPIC 1: GRANTING USER ACCESS TO DECLARATIONS 

INTRODUCTION 

Declarations are statements the importer or his or her agent make that support an imported merchandise claim. 
The following blanket declarations are supported in the Automated Commercial Environment (ACE) Secure Data 
Portal: 

 Affidavit of Manufacture 
 Importer Certifying Statement 
 Non-Reimbursement Blanket Statement (Antidumping/Countervailing Duty) 
 North American Free Trade Agreement (NAFTA) Certificate of Origin 

U.S. Customs and Border Protection (CBP) and Trade account users with access to the declarations hyperlink 
can view declaration records created in ACE. 

Importers, brokers, carriers, and filers can submit declaration records, which are associated at the Importer of 
Record level in the account. Brokers or filers who would like to input declaration records on behalf of importers 
with ACE Portal accounts require access to the importer’s account. Brokers or filers can also create declaration 
records for their importers without an ACE portal account. 

The Trade Account Owner (TAO) must grant access to the Declarations hyperlink to any Proxy Trade Account 
Owner (PTAO) and Trade Account User (TAU) who needs access. 

NOTE: Declaration records can be created in ACE to support ACE entry summaries. Once a 
declaration record has been submitted, it cannot be edited or deleted. However, a declaration record 
may be cancelled. 

GRANTING USER ACCESS TO DECLARATIONS 

1. In the ACE Secure Data Portal, select the Tools tab. 

2. In the Task Selector panel, select the User Access hyperlink. 

The User Access panel displays a list of your users. 

3. In the User Access panel, in the Last Name column, select the hyperlink of the last name of 
the user to edit. 

The User Access portlet displays with the account information of the user. 

NOTE: You can change the options for User Role and Access to Top Account, 
if needed. 

4. In the User Access panel, select the Continue button to view the current access for the 
selected user. 

5. In the User Access panel, select either the Broker or the Importer sub-tab. 

6. In the Broker sub-tab, select the Edit Broker Permissions hyperlink 

OR 

In the Importer sub-tab, select the Edit Importer Permissions hyperlink. 
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7. In the Broker or the Importer sub-tab, select the appropriate radio button for access to the 
Declarations hyperlink. 

NOTE: Full Access allows the user to search, display, create, and cancel 
declaration records. Read Only Access allows the user to search and display 
declaration records. No Access means the Declarations hyperlink will not be 
displayed in the Task Selector panel. 

8. Select the Continue button. 

Changes are displayed in the Permissions column indicating the new access privileges have 
been granted. 

9. Select the Save button. 
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TOPIC 2: CREATING A DECLARATION RECORD (PORTAL ACCOUNT) 

INTRODUCTION 

The following key points apply when creating a declaration record for an Importer ACE Portal account: 

 TAOs, PTAOs, and TAUs with full access to Declarations can create declaration records. 
 Declaration records only need to be created once. Once it is created, the declaration record can be viewed 

nationally by CBP via the ACE Portal. 
 If the importer has an ACE Portal account, declaration records should only be created at the Importer of 

Record level in the account. 
 Once a declaration record is submitted, it cannot be edited or deleted. 
 The maximum number of: 

o Cases per declaration record is 50. 
o Manufacturer Identification (MID) numbers per declaration record is 50. 
o Harmonized Tariff Schedule numbers (HTS) per declaration record is 50. HTS numbers entered 

must be at least six digits. 
 A comma is used to separate multiple HTS numbers, MIDs, and cases. 
 Enter at least seven digits of the Case Number for a Non-Reimbursement Blanket Statement 

(AD/CVD). Remember to check the AD/CVD Non-Reimbursement Statement box. 
 Attachments made to declaration records are date and time stamped. 
 The North American Free Trade Agreement (NAFTA) Certificate of Origin requires the attachment 

of a copy of the official document to complete the posting of the declaration record. See Business 
Rules and Process Document (Trade) posted on CBP.gov for more information. 

IMPORTANT: An error message will not display in the portal if you forget the attachment. 
However, CBP will not consider the declaration record to be completed. 

CREATE A DECLARATION RECORD (PORTAL ACCOUNT) 
1. In the ACE Secure Data Portal, select the Accounts tab. 

2. In the Account Selector List panel: 

a. In the Select Account Type field, select Importer from drop-down menu. 

b. Select the Go button. 

3. In the Account Selector List panel: 

a. In the Accounts section, select the + icon to choose the Importer of Record number. 

b. Select the hyperlink for the Importer of Record number. 

4. In the Task Selector panel: 

a. Select the Declarations hyperlink. 

b. Select the Portal Account hyperlink. 

5. In the Declarations portlet, select the Create button. 
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6. In the Create Declaration portlet: 

a. In the Declaration Type: drop-down menu, select a declaration type. 

NOTE: Options for declaration type include Affidavit of Manufacture, 
Importer Certifying Statement, Non-Reimbursement Blanket Statement 
(AD/CVD), or North American Free Trade Agreement (NAFTA) Certificate 
of Origin 

b. In the Date Valid From: field, select the Calendar icon to select a date for all 
declaration types. 

c. In the Date Valid To: field, select the Calendar icon to select a date for all 
declaration types. 

d. In the Ruling #: field, type a ruling # that is associated to the declaration type. 

e. In the Case #: field, type the case number for the Non-Reimbursement Blanket 
Statement (AD/CVD) declaration type only. 

f. In the Manufacturer ID#: field, type the manufacturer ID number for all declaration 
types except NATFA Certificate of Origin. 

g. In the All MID #s: field, select the checkbox for the Non-Reimbursement Blanket 
Statement (AD/CVD) declaration type only. 

h. In the HTS #: field, type an HTS number for all declaration types with the exception 
of Non-Reimbursement Blanket Statement (AD/CVD). 

i. In the Comments: field, type any comments that need to be associated to the 
blanket declaration. 

j. Select the Continue button. 

NOTE: The Manufacturer ID must be on file prior to creating the 
declaration. In the case of the Non-Reimbursement Blanket 
Statement (AD/CVD) either the Manufacturer ID# or All MID #s is 
required. If you are creating a Non-Reimbursement Blanket 
Statement (AD/CVD), you are required to check the AD/CVD Non-
Reimbursement Statement box. If reimbursement has not 
occurred, you should check the All MID #s checkbox. 

NOTE: You may also select the Continue without Attachment button. 
Although you are not required to attach documents to declaration records 
(except in the case of a NAFTA Certificate of Origin), you are encouraged 
to do so. CBP can request a copy of the actual document. 

7. In the Create Declaration panel: 

a. Select the Browse button. 

b. Locate the file you want to add. 

c. Select the Attach File button to attach the document to the declaration record. 

d. Select the Continue button. 

8. Select the Submit button after you have reviewed the declaration record information. 

A Confirmation screen displays containing the Declaration Number. 
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9. Select the OK button to save the declaration record you created. 

NOTE: When submitting ACE entry summaries (entry type 03), filers can now 
include the declaration number as part of their EDI transmission. A system 
generated declaration number is assigned when the blanket declaration record has 
been successfully created in ACE. The number displays in the Confirmation panel. 
Importers must provide the applicable declaration number to their filers for 
declaration records created in ACE. 
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TOPIC 3: SEARCH FOR A DECLARATION RECORD (PORTAL ACCOUNT) 

INTRODUCTION 

Authorized users with Read Only Access and Full Access can search for and display declaration records. 
All declaration records associated with an account display on the Declarations screen. Users can search 
for declaration records at the Top account level or at the Importer of Record level. A maximum of 500 
declaration records can be displayed in the ACE Portal. 

Acronyms are used to indicate Declaration types: 

 Affidavit of Manufacture: AM 
 Importer Certifying Statement: ICS 
 NAFTA Certificate of Origin: NAFTA_CO 
 Non-Reimbursement Blanket Statement (AD/CDV): NRBS 

If you are searching using the Declaration number, no other criteria are required to execute the search. 

SEARCH FOR A DECLARATION RECORD (PORTAL ACCOUNT) 
1. In the ACE Secure Data Portal, select the Accounts Tab. 

2. In the Task Selector panel: 

a. In the Select Account Type field, select Importer from the View: drop-down menu. 

b. Select the Go button. 

3. In the Account Selector List panel in the Accounts section, select either the top account, 
or an Importer of Record number. 

4. In the Task Selector panel, select the Declarations hyperlink. 

5. In the Declarations panel: 

a. Select at least two search criteria to narrow the list of declaration records. 

NOTE: To search for a declaration record, you must enter at least two of the 
following criteria: Valid From, Valid To, Status, Status Date, Declaration #, 
Declaration Type, All MID #s, Manufacturer ID #, Manufacturer Name, 
Ruling #, HTS #, or Case #. A wildcard search using the asterisk is allowed 
in all fields except those containing a drop- down menu. 

b. Select the Filter button. 

6. In the Search Results in the Decl. # column, select the Decl. # hyperlink of the declaration 
record you wish to display. 

The Declaration Information panel displays. 

NOTE: The term Multiple in the Case # column indicates there is more than one 
AD/CVD case number associated with the declaration record. Select the Decl. # 
hyperlink to display a listing of cases associated with the selected declaration 
record. If only one ten digit case number is associated with the declaration 
record, users can select the case number hyperlink to navigate to the case 
information. 
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The Case #, Manufacturers, and HTS Numbers sub-tabs allow the user to see 
all case numbers, manufacturers, and HTS numbers associated with the 
declaration record. The Attachments sub-tab displays any document attached to 
the declaration record selected. 

7. Select the OK button to return to the list of declaration records. 
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TOPIC 4: PRINTING A DECLARATION RECORD (PORTAL ACCOUNT) 

INTRODUCTION 

After you have displayed the declaration record based on your search criteria, you can save a copy to your 
computer or print the declaration record. 

PRINTING A DECLARATION RECORD (PORTAL ACCOUNT) 
1. In the Declarations panel, select the Print Page hyperlink. 

A window displays with the requested data in a PDF format for review before printing. 

NOTE: The Declaration Information includes information on the Case #, 
Manufacturers, and HTS # sub-tabs. Only the attachment name from the 
Attachments sub-tab displays with the declaration record information. 

2. At the top of the page, select the File tab, then select Print to print the screen 
displayed. 

The Print dialog box displays. 

3. In the Print dialog box: 

a. Make the appropriate selections. 

b. Select the OK button. 

NOTE: To print any attachments, select the Attachments sub-folder. The file 
name displays. Select the link to the file name and follow steps 2 and 3 above to 
print the attachment. 
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TOPIC 5: CANCELLING A DECLARATION RECORD (PORTAL ACCOUNT) 

INTRODUCTION 

CBP personnel and authorized trade users who have full access to Declarations can cancel declaration records. 
Cancelled declaration records remain in the ACE Portal with a status of Cancelled. 

A cancelled declaration record is invalid for a Non-Reimbursement Blanket Statement (AD/CVD). 

When using the Declaration number to search, no other criteria are required to execute the search. 

CANCELLING A DECLARATION RECORD (PORTAL ACCOUNT) 
1. In the ACE Secure Data Portal, select the Accounts Tab. 

2. In the Task Selector panel: 

a. In the Select Account Type field, select Importer from the View drop-down menu. 

b. Select the Go button. 

3. In the Account Selector List panel, select either the top account or an Importer of Record 
number. 

4. In the Task Selector panel, select the Declarations hyperlink. 

5. In the Declarations panel: 

a. Select at least two search criteria to narrow the list of declaration records. 

NOTE: To search for a declaration record, you must enter at least two of 
the following criteria: Valid From, Valid To, Status, Status Date, 
Declaration #, Declaration Type, All MID #s, Manufacturer ID #, 
Manufacturer Name, Ruling #, HTS #, or Case #. A wildcard search using 
the asterisk is allowed in all fields except those containing a drop-down. 

b. Select the Filter button. 

6. In the Search Results in the Decl. # column, select the declaration number hyperlink of the 
declaration record to display. 

The Declaration Information panel displays. 

7. In the Declaration Information panel, select the Cancel Declaration button. 

8. In the confirmation dialog box, select the OK button. 
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TOPIC 6: CREATING A DECLARATION RECORD (NON-PORTAL ACCOUNT) 

INTRODUCTION 

The following key points apply when creating a declaration record for a Non- Portal account: 

 TAOs, PTAOs, and TAUs with full access to Declarations can create declaration records. 
 Declaration records only need to be created once. Once it is created, the declaration record can be viewed 

nationally by CBP at any port via the ACE Portal. 
 Once a declaration record is submitted, it cannot be edited or deleted. 
 Declaration records created by brokers or filers on behalf of their importer non-portal accounts (e.g., 

clients who do not have ACE Portal accounts) are created under the importer view. 
 The maximum number of: 

o Cases per declaration record is 50. 
o MID numbers per declaration record is 50. 
o HTS numbers per declaration record is 50. HTS numbers entered must contain at least six digits. 

 A comma is used to separate multiple HTS numbers, MIDs, and cases. 
 Enter at least seven digits of the Case Number for a Non-Reimbursement Blanket Statement 

(AD/CVD). Remember to check the AD/CVD Non-Reimbursement Statement box. 
 Attachments made to declaration records are date and time stamped. 
 The NAFTA Certificate of Origin requires the attachment of a copy of the official document to 

complete the posting of the declaration record. See Business Rules and Process Document 
(Trade) posted on CBP.gov. 

IMPORTANT: An error message will not display in the portal if you forget the attachment. 
However, CBP will not consider the declaration record to be completed. 

CREATE A DECLARATION RECORD (NON-PORTAL ACCOUNT) 
1. In the ACE Secure Data Portal, select the Accounts tab. 

2. In the Task Selector panel: 

a. In the Select Account Type elect Importer from the View: drop-down menu. 

b. Select the Go button. 

3. In the Task Selector panel: 

a. Select the Declarations hyperlink. 

b. Select the Non-Portal Account hyperlink. 

4. In the Declarations panel, select the Create button. 

5. In the Declaration Type: field, select a Declaration Type from the drop-down menu. 

a. 

NOTE: Options for declaration type include Affidavit of Manufacture, Importer 
Certifying Statement, Non-Reimbursement Blanket Statement (AD/CVD), or North 
American Free Trade Agreement (NAFTA) Certificate of Origin. 

In the Date Valid From: field, select the Calendar icon to select a date for all 
declaration types. 
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b. In the Date Valid To: field, select the Calendar icon to select a date for all 
declaration types. 

k. In the Ruling #: field, type a ruling # that is associated to the declaration type. 

l. In the Case #: field, type the case number for the Non-Reimbursement Blanket 
Statement (AD/CVD) declaration type only. 

m. In the Manufacturer ID#: field, type the manufacturer ID number for all declaration 
types except NATFA Certificate of Origin. 

n. In the All MID #s: field, select the checkbox for the Non-Reimbursement Blanket 
Statement (AD/CVD) declaration type only. 

o. In the HTS #: field, type an HTS number for all declaration types with the exception 
of Non-Reimbursement Blanket Statement (AD/CVD). 

p. In the Comments: field, type any comments that need to be associated to the 
blanket declaration. 

c. Select the Continue button. 

NOTE: The Manufacturer ID must be on file prior to creating the 
declaration. I. In the case of the Non-Reimbursement Blanket Statement 
(AD/CVD) either the “Manufacturer ID#” or All MID #s is required. If you 
are creating a Non-Reimbursement Blanket Statement (AD/CVD), you are 
required to check the AD/CVD Non-Reimbursement Statement box. If 
reimbursement has not occurred, you should check the All MID #s box. 

NOTE: You may also select the Continue without Attachment button. Although 
you are not required to attach documents to declaration records (except in the 
case of a NAFTA Certificate of Origin), you are encouraged to do so. CBP can 
request a copy of the actual document. 

6. In the Create Declaration panel: 

a. Select the Browse button. 

b. Locate the file you want to add. 

c. Select the Attach File button to attach the document to the declaration record. 

d. Select the Continue button. 

7. Select the Submit button after you have reviewed the declaration record information. 

A Confirmation screen displays containing the Declaration Number. 

8. Select the OK button to save the declaration record you created. 

NOTE: When submitting ACE entry summaries (entry type 03), filers can now 
include the declaration number as part of their EDI transmission. The declaration 
number, a system generated number, is assigned when the blanket declaration 
record has been successfully created in ACE. The number displays in the 
Confirmation panel. Importers will need to provide the applicable declaration 
number to their filers for declaration records created in ACE. 
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TOPIC 7: SEARCH FOR A DECLARATION RECORD (NON-PORTAL ACCOUNT) 

INTRODUCTION 

Authorized users with Read Only Access and Full Access can search for and display declaration records. 
All declaration records associated with the account display on the Declarations screen. Users can only 
search for declaration records created for non-portal accounts at the Top account level. A maximum of 
500 declaration records can be displayed. 

Acronyms are used to indicate Declaration types: 

 Affidavit of Manufacture: AM 
 Importer Certifying Statement: ICS 
 NAFTA Certificate of Origin: NAFTA_CO 
 Non-Reimbursement Blanket Statement (AD/CDV): NRBS 

When using the Declaration number to search, no other criteria are required to execute the search. 

SEARCH FOR A DECLARATION RECORD (NON-PORTAL ACCOUNT) 
1. In the ACE Secure Data Portal, select the Accounts Tab. 

2. In the Task Selector panel: 

a. In the Select Account type field, select Importer from the View: drop-down menu. 

b. Select the Go button. 

3. In the Task Selector panel, select the Declarations hyperlink. 

4. In the Declarations panel: 

a. Select at least two search criteria to narrow the list of declaration records. 

NOTE: To search for a declaration record, you must enter at least two of 
the following criteria: Valid From, Valid To, Status, Status Date, 
Declaration #, Declaration Type, All MID #s, Manufacturer ID #, 
Manufacturer Name, Ruling #, HTS #, or Case #. A wildcard search using 
the asterisk is allowed in all fields except those containing a drop-down. If 
you are searching using the Declaration #, no other criteria are required 
to execute the search. 

b. Select the Filter button. 

A list of declaration records matching the search criteria displays. 

NOTE: Declaration records are sorted initially by declaration record 
number. Only 10 declaration records display at a time. If you enter the 
Declaration # then only that declaration record displays. 

5. In the Search Results section in the Decl. # column, select the Decl. # hyperlink of the 
declaration record you wish to display. 

The Declaration Information panel displays. 

NOTE: The term Multiple in the Case # column indicates there is more than one 
AD/CVD case number associated with the declaration record. Select the Decl # 
hyperlink to display a listing of cases associated with the selected declaration 
record. If only one ten digit case number is associated with the declaration 
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record, users will be able to select the case number hyperlink to navigate to the 
case information. 

The Case #, Manufacturers and HTS Numbers sub-tabs allow the user to see 
all case numbers, manufacturers and HTS numbers associated with the 
declaration record. The Attachments sub-tab will display any document attached 
to the declaration record selected. 

6. In the Declaration Information panel, select the OK button to return to the list of 
declaration records. 
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TOPIC 8: PRINTING A DECLARATION RECORD (NON-PORTAL ACCOUNT) 

INTRODUCTION 

After you have displayed the declaration record based on your search criteria, you can save a copy to your 
computer or print the declaration record. 

PRINTING A DECLARATION RECORD (NON-PORTAL ACCOUNT) 
1. In the Declaration panel, select the Print Page link. 

A window displays with the requested data in a PDF format for review before printing. 

NOTE: The Declaration Information includes information on the Case #, 
Manufacturers, and HTS # sub-tabs. Only the attachment name from the 
Attachments sub-tab displays with the declaration record information. 

2. At the top of the page, select the File tab, then select Print to print the screen displayed. 

The Print dialog box displays. 

3. In the Print dialog box: 

a. Make the appropriate selections. 

b. Select the OK button. 

NOTE: To print any attachments, select the Attachments sub-folder. The file 
name displays. Select the link to the file name and follow steps 2 and 3 above to 
print the attachment. 
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TOPIC 9: CANCELLING A DECLARATION RECORD (NON-PORTAL ACCOUNT) 

INTRODUCTION 

CBP personnel and authorized trade users who have full access to Declarations can cancel declaration records. 
Cancelled declaration records remain in the ACE portal with a status of Cancelled. 

A cancelled declaration record is invalid for a Non-Reimbursement Blanket Statement (AD/CVD). 

When using the Declaration number to search, no other criteria are required to execute the search. 

CANCELLING A DECLARATION RECORD (NON-PORTAL ACCOUNT) 
1. In the ACE Secure Data Portal, select the Accounts Tab. 

2. In the Task Selector panel: 

a. In the Select Account type field, select Importer from the View: drop-down menu. 

b. Select the Go button. 

3. In the Task Selector panel, select the Declarations hyperlink. 

4. In the Declarations panel: 

a. Enter at least two search criteria to narrow the list of declaration records. 

NOTE: To search for a declaration record, you must enter at least two of 
the following criteria: Valid From, Valid To, Status, Status Date, 
Declaration #, Declaration Type, All MID #s, Manufacturer ID #, 
Manufacturer Name, Ruling #, HTS #, or Case #. A wildcard search using 
the asterisk is allowed in all fields except those containing a drop down. 

b. Select the Filter button. 

5. In the Search Results section in the Decl. # column, select the Decl. # hyperlink for the 
declaration record to display. 

The Declaration Information panel displays. 

6. In the Declaration Information panel, select the Cancel Declaration button. 

7. In the confirmation dialog box, select the OK button. 
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